Avid

Avid Xpress® DV

Release 3.0 Release Notes

for the Windows® 2000 Operating System

Important Information

Avid recommends that you read all the information in these release notes thoroughly before installing or using any new software release.

This document pertains to Release 3.0 of Avid Xpress® DV for the Windows® 2000 Professional operating system. This document describes compatibility issues with previous releases, hardware and software requirements, and summary information on system and memory requirements. This document also lists known issues or limitations.

Contents

Symbols and Conventions ........................................... 5
If You Need Help ......................................................... 5
New Features ............................................................. 6
Hardware and Software Requirements ......................... 6
  System Configurations ............................................. 6
  DV In/DV Out Cards ............................................... 7
    OHCI Chip - TI 1394 Integrated Circuit Device .......... 7
  Installation and the OHCI Drivers ............................. 7
    Linking the Driver to a New DV Device .................... 7
    If You See the Found New Hardware Device Wizard ...... 8
Uninstalling Previously Loaded Third-Party Applications . . 22
  Avid AVI Codec Uninstall ................................. 23
Preparing Your System for DVD Creation .................. 24
  Project Sample Rate and a DVD ............................. 24
  Create DVD Commands ....................................... 24
  Create DVD Requires DirectX 8.1 ........................... 24
Recommended Workflow for Creating DVDs with
  Avid Xpress DV ............................................. 25
  cleaner EZ ................................................... 26
  Pinnacle Commotion DV (PowerPack Users Only) ............ 27
  MPEG-2 Files .................................................. 27
  Sonic Solutions .............................................. 28
  RealPlayer ................................................. 28
  Web Software ............................................... 29
Suggestions for Optimum Performance ..................... 29
Documentation for Release 3.0 ............................. 31
  Hardcopy Documentation .................................... 31
  Avid Xpress DV Getting Started Guide Change .......... 32
  Avid Xpress DV Help ....................................... 32
  Using Dual Monitors ....................................... 32
  Track Selector Repositioning ............................. 33
  Connecting to Both a Transcoder and the Remote
    Output on a Deck ......................................... 33
  Avid Xpress DV User’s Guide Change ..................... 33
  Refreshing Media Databases ................................ 34
  Avid Xpress DV Effects Guide Change ................... 34
  Non-Keyframeable Effects ................................ 34
Additional Notes on Operation ............................. 35
  Audio ......................................................... 35
  Digital Cut ................................................. 36
  Effects ....................................................... 37
  Export ....................................................... 37
  Import ....................................................... 38
Symbols and Conventions

These release notes use the following special symbols and conventions:

- **Note**: Provides important related information, reminders, recommendations, and strong suggestions.

- **Caution**: Means that a specific action you take could cause harm to your computer or cause you to lose data.

- **Warning**: Describes an action that could cause you physical harm. Follow the guidelines in the manual or on the unit itself when handling electrical equipment.

- **Arrow**: Indicates a known bug or limitation. Where appropriate, a workaround is provided.

If You Need Help

To access the Avid Web site for product-related information (system specifications):

- Go to www.avid.com/xpressdv.

To access the Avid Knowledge Center for technical tips, documentation, downloads, and camera lists:

2. Click Support.
3. Click Online Support.
4. Click the online technical support database link.
5. Select Avid Xpress DV.
New Features


Hardware and Software Requirements

Avid Xpress DV requires the following system configuration:

- Windows 2000 Professional operating system with Service Pack 2
- Minimum of 256 MB of RAM

To verify the version of the operating system, service pack, and RAM:
1. Right-click the My Computer icon on your desktop, and choose Properties.
2. Click the General tab.
   
   It displays your operating system version, service pack version, and available memory.
3. Click OK to close the System Properties dialog box.

System Configurations

For an updated list of supported system configurations and known issues, see the Avid Web site.
2. Click Products.
3. Choose Avid Xpress DV.
DV In/DV Out Cards

Avid Xpress DV supports the Open Host Controller Interface (OHCI)-compliant IEEE®-1394 chip (based on Texas Instruments™ technology). For the most up-to-date list, go to www.avid.com.

OHCI Chip - TI 1394 Integrated Circuit Device

The TI (Texas Instruments) OHCI chip is the only OHCI chip that Avid has qualified to use with the Avid Xpress DV system. Avid will only support, and highly recommends, the use of the TI 1394 Link and PHY chip.

Installation and the OHCI Drivers

Avid Xpress DV does not use the default WIN2K OHCI driver, but uses a custom OHCI driver. Whenever you connect a new camera or deck (DV device) to the system via OHCI 1394, you have to link the device with Avid’s custom OHCI driver rather than the default driver. There are two scenarios under which you should follow this process:

- You have not previously connected a DV device.
- You have previously connected a DV device and used the Microsoft® OHCI 1394 driver.

You can also link a DV device to a particular driver if you want to use a driver other than the custom OHCI driver.

Linking the Driver to a New DV Device

To link with the correct driver if you have not previously connected a DV device:

1. Start the Avid Xpress DV application before connecting the camera or deck via the OHCI 1394 driver and turning it on.
2. Connect the DV device, and then turn it on.
   An hourglass cursor appears.

4. The dialog box instructs you to turn the DV device off and then on so the proper driver can be installed.

5. Click OK, and turn the DV device off and then on. The Found New Hardware Wizard and the dialog box close.

This establishes communication with the DV device via the custom OHCI driver.

**If You See the Found New Hardware Device Wizard**

If you turn on the DV device before you start Avid Xpress DV, the Found New Hardware Wizard appears.

1. Press Cancel to close the Found New Hardware Wizard.

2. Turn off the DV device and go to step 1 in “Linking the Driver to a New DV Device” on page 7 or “Linking the Driver to a DV Device Previously Linked to a Different Driver” on page 8.

*Note: Avid recommends that you let the Avid Xpress DV application link to the correct driver for you. For more information on how to configure the Found New Hardware Wizard, see Chapter 2 of the Avid Xpress DV Getting Started Guide.*

**Linking the Driver to a DV Device Previously Linked to a Different Driver**

To link with the correct driver if you have previously connected a DV device that was linked to a different driver:

1. Start the Avid Xpress DV application.

2. Turn on the DV device.

   The Wrong DV Driver Active dialog box appears, instructing you to turn the DV device off.

3. Turn the DV device off, and then click Yes.
The DV Driver Replaced dialog box appears, instructing you to turn the DV device back on.

4. Turn the DV device on, and then click OK.

This establishes communication with the DV device via the custom OHCI driver.

If Avid Xpress DV stops communicating with the camera or deck, try turning the DV device off and then on.

**Linking DV Devices to a Particular Driver**

You can use the DVSelect utility to link to a driver other than the custom OHCI driver. For example, you might need to use the Microsoft driver with a third-party application.

**To link to a driver other than the custom OHCI driver:**

1. Connect and turn on any DV device.
2. Click Start>Programs>Avid>Utilities, and select DVSelect.
   
   The DV Driver Select dialog box appears.
3. Select one of the following:
   - Microsoft DV Camera and VCR Driver
   - Avid/Texas Instruments 1394 DV Camcorder Driver
4. Select “Switch drivers for only those devices that are currently turned on.”
   
   If you do not select this option, the driver is linked to all devices you have ever connected to the system.
5. Connect and turn on any DV devices you want to link to the selected driver.
6. Click OK.

   The selected driver is linked to the currently connected devices that are turned on.
Warning Regarding Your Application Key (Dongle)

The application key, commonly referred to as a dongle, allows the Avid Xpress DV software to run on your system. Protect your application key from loss or theft because your Avid Xpress DV software does not function without it, and acquiring a new application key from Avid involves a fee.

Avid Storage Manager Support

Avid Storage Manager (ASM) is a drive diagnostic utility used for testing Avid media drives. In Avid Xpress DV Release 3.0, ASM replaces the Avid StorEx utility. ASM includes context-sensitive Help. Most windows in the ASM utility include a Help button that when clicked, opens a browser window that provides information about the current ASM window displayed.

An online user’s guide is also included in Program Files\Utilities\Avid Storage Manager\ASMug.pdf.

Avid recommends that you do not run ASM unless instructed by Avid Customer Support. Many of the utility's functions can destroy the data on the drives.

Setting the Paging File

For best performance, Avid recommends that you set the paging file size to 384 MB.

The recommended paging file should be set to 384 MB for both the Initial (minimum) and Maximum size. This will help prevent disk fragmentation. You should install a paging file on a system drive that is not used for media.
To set the paging file:

1. Click the Start button, point to Settings, and then select Control Panel.
2. Double-click System.
3. Click the Advanced tab in the System Properties dialog box.
4. Click Performance Options.
5. In the Virtual Memory section, click Change.
6. Select the appropriate drive.
7. Set Initial size and Maximum size to 384 MB.
8. Click OK.

FireWire Support

At this time, Avid supports the use of only one FireWire® port at a time. You can have only a single DV device connected to the Avid Xpress DV system at one time. For example, if you have a camera connected to your system and want to use a video deck, you will have to disconnect your camera and then connect the video deck.

This limitation does not pertain to FireWire drives.

Screen Resolution

Avid requires the following for your system to run the Avid Xpress DV application:

- The Screen area (in the Display Properties dialog box) set to a minimum of 1024 by 768 pixels
- The Colors (in the Display Properties dialog box) set to True Color 32 bit (High Color 16 bit for systems with video cards that don’t have 32 MB of memory)
- The Refresh Frequency (in the Monitor tab of the Advanced settings in the Display Properties dialog box) set to 75 Hertz as your screen resolution

Dual-monitor systems also require a minimum Screen area of 1024 by 768 pixels.

Higher screen resolutions can be used. Screen resolutions are limited by the system's graphics board and the monitor specifications.

**NTFS and Media Files**

Avid recommends storing media on an NTFS file system. If you use something other than NTFS (FAT or FAT32), the system might not rebuild your media database under certain circumstances.

If you receive an error message “Unsupported Resolution Error” in NTSC or “Compression_Not_Supported” in PAL, you need to delete the msmFMID.pmr file. Locate Program Files\Avid\Avid Xpress DV\SupportingFiles\Avid_MediaFiles. Click the msmFMID.pmr file, and delete it.

**Eject Disk Warning with IDE System Drives**

⚠️ In the Avid Xpress DV application, do not choose Eject Disk from the File menu if you have IDE drives. Choosing Eject Disk causes a system error and might cause you to lose unsaved data.

With the current release, the Eject Disk command allows you to select SCSI media drives only and make them inaccessible to Avid Xpress DV. This command does not work with IDE system drives.
Installing the Software

For information on installing the Avid Xpress DV software and other applications, see the instructions in Chapter 2 of the *Avid Xpress DV Getting Started Guide*.

Registering Your Avid Xpress DV Release 3.0 Product

You must register your product to receive important information about Avid Xpress DV; this also covers the product under its warranty.

To register your Avid Xpress DV Release 3.0 product, fill out the Avid Xpress DV Product Registration form.

**To register your copy of Avid Xpress DV:**

1. When you first start the Avid Xpress DV application, you will be asked to accept the License Agreement and then register your copy of Avid Xpress DV.

   The Product Registration dialog box appears. This allows you to register your Avid Xpress DV product.

2. Click one of the following buttons:
   - **Register Online** – Opens a Web browser with the Avid Xpress DV Product Registration form. Fill out the form, and click Submit.
   - **Display Registration Form to Print** – Opens the Avid Xpress DV Product Registration form that allows you to print the form, fill it out, and then mail it to Avid.
- **Don’t Register Now** – Click this button if you do not want to register your product at this time.

You can also obtain the online and printable versions of the Avid Xpress DV Product Registration form from within the Avid Xpress DV application. Choose Product Registration from the Help menu, and then choose either Register Online or Display Registration Form to Print.

## Installing the Avid Xpress DV PowerPack CD-ROM

If you purchased the Avid Xpress DV Power Pack CD-ROM, install this after you install the Avid Xpress DV application CD-ROM.

Included on the Avid Xpress DV PowerPack CD-ROM are:

- **Illusion FX Pack**: Includes 30 effect plug-ins. Documentation describing these effects is included in the Goodies folder (called IllusionFXPack) on the Avid Xpress DV application CD-ROM.

- **Region Stabilize effect**: This effect gets installed with the Illusion FX Pack. Documentation describing this effect is included in the Help and in the *Avid Xpress DV Effects Guide*.

- **Avid Log Exchange (ALE)**: Documentation describing ALE is included in the Help and in the *Avid Xpress DV User’s Guide*.

- **FilmScribe™**: Documentation is included on the *Avid Xpress DV Online Publications* CD-ROM.

## Avid Xpress DV Tutorial CD-ROM Recommendation

Avid recommends that you remove the Avid Xpress DV Tutorial CD-ROM from the CD-ROM drive before you start the Avid Xpress DV application.
Customer Support

The Avid Xpress DV system is supported by Avid and your PC vendor. Avid offers a 30-day free support period upon registration.

You must register your Avid Xpress DV system to take advantage of this 30-day support period. For instructions on registering, see “Registering Your Avid Xpress DV Release 3.0 Product” on page 13.

If You Need Help

If you are having trouble using Avid Xpress DV, you should do the following:

1. Check the documentation. For procedural steps, check the Avid Xpress DV Help. For questions regarding your computer, contact your PC vendor’s Help Center. For questions regarding your deck, camera, or transcoder, call the appropriate manufacturer.

2. Check the Knowledge Center at www.avid.com. This Web site offers the latest known issues, solutions to errors, technical tips, and operational support for the Avid Xpress DV system.

3. For operational and how-to questions regarding the Avid Xpress DV software:

   In the U.S. and Canada, contact Avid Customer Support at 800-800-AVID (2843) or 978-275-2476. In Europe, contact your Avid Reseller or the Avid International Information Desk at +44 1753 658 482. When you call, have your software serial number available, found on the label attached to your application key (dongle).

   Additional information on how to obtain support can be found at www.avid.com. Internet-based support is always available free of charge.
Support Packages

The following customer support services are available:

- Avid On-Call per-event telephone support.
- Avid CallPak (10-pack), good on any system at a given site.
- Avid Assurance annual contract, unlimited telephone support from 9 a.m. to 7 p.m., local time in North America. (Part# 0540 03180-01)

International time varies by location. Contact your local Avid Reseller for details.

To purchase a support package, call 800-949-AVID (2843).

There is no 7 x 24 offering planned for this product.

Goodies Folder

The Avid Xpress DV CD-ROM includes a Goodies folder. This folder contains third-party applications or plug-ins you can use.

The information in the Goodies folder is provided solely for your reference and as suggestions for you to decide if any of these products fit into your process. Avid is not responsible for the manufacture, support, or sales of these products. Avid is also not responsible for any loss of data or time or any other adverse results related to the use of those products. All risks of using such products or accessing such Web sites are entirely your own. The Web sites listed in the Goodies folder are not under the control of Avid, and Avid is not responsible for their content, any changes or updates to them, or the collection of any personal data or information by the operators of such sites. All information and product availability is subject to change without notice.
To open the Goodies folder when the icon is not on your desktop:

1. Insert the Avid Xpress DV CD-ROM.
2. Click Browse CD.
3. Double-click the Goodies folder.

Cameras, Decks, and Transcoders

To access the most up-to-date information on DV devices check the Knowledge Center.

*If you have a problem connecting or using your DV device, check the manual that came with your DV device.*

Black Striping Your Tape

Before you perform a digital cut, Avid recommends that you black stripe your tape. This allows for timecode on your tape.

Audio

Refer to the following sections for information regarding audio.

Audio Sound Cards

Avid Xpress DV supports using only one sound card at a time. If your system has multiple sound cards, the system needs to know which sound card to use.
To choose an audio sound card:

1. Click the Start button, point to Settings, and then select Control Panel.
2. Double-click Sounds and Multimedia.
   The Sounds and Multimedia Properties dialog box appears.
3. Click the Audio tab.
4. Select “Use only preferred devices.”
5. The Preferred device for Sound Playback and Sound Recording should display the same device.
6. In the Sound Playback section, click Advanced.
   The Advanced Audio Properties dialog box appears.
7. Click the Performance tab.
8. Set the Hardware acceleration slider to Full.
9. Click OK.
10. In the Sound Recording section, click Advanced.
    The Advanced Audio Properties dialog box appears.
11. Set the Hardware acceleration slider to Full.
12. Click OK.

Consumer audio cards exhibit differences with the phasing and polarity of the audio signal. Tolerances will vary with each brand of card. These limitations are inherent to the hardware and will display in all applications that play audio through the card.

Sound Blaster Audigy Card

If you are using a Sound Blaster® Audigy card with Avid Xpress DV, after a few minutes of play, the sound will no longer be heard through the card output. The only way to fully restore the output is to quit and reboot the system. Avid has traced this problem to the Sound Blaster
Audigy driver installation. Use the following instructions to install your Sound Blaster Audigy card.

**Installing the Sound Blaster Audigy Card in an Avid Xpress DV System**

To install the Audigy card:

1. Shut down your system.
2. Install the Sound Blaster Audigy card into an open PCI slot.
3. Start your system.
4. Log in.
   
The Hardware Wizard should have found the new hardware.
5. Insert the Sound Blaster Audigy Installer CD-ROM that came with the Audigy card but *do not* run the installer application.
6. Use the Hardware Wizard to browse the Installer CD-ROM for an appropriate audio device driver.
7. Use the Hardware Wizard to install the audio device driver found on the Installer CD-ROM.
8. Restart the system when prompted.
9. Log in.
   
The Hardware Wizard might run again, trying to install a driver for the game port.
10. Use the Hardware Wizard to search the Installer CD-ROM for an appropriate game port driver.
11. Use the Hardware Wizard to install the game port driver that is found on the Installer CD-ROM.

*The installer that comes with the Audigy card includes many applications and installers. Some of these applications will not run with the driver installation described above. Install these at your own risk. The specific applications that might have a conflict are Creative TaskBar and EAX Audio Effect Controls.*
Updating Audio Drivers

When you start the Avid Xpress DV application and you receive this error message, “Can’t find any audio cards in your system. You will not be able to play audio,” or you get an exception error “WIN32MIXER” when you initialize audio, you will need to update your audio driver to a newer version.

If you have a sound card that you use for audio, go to the sound card manufacturer’s Web site and look for the most recent audio driver for Windows 2000 Professional for that card.

If you are using the onboard audio chip in your computer, go to the computer manufacturer’s Web site and look for the most recent audio driver for your computer model for Windows 2000 Professional.

Other Audio Applications

To avoid contention over system audio resources, do not start any other audio application while running the Avid Xpress DV application. If you want to use a CD-ROM player, use the cdplayer.exe supplied with your system.

To start the cdplayer.exe:
1. Click the Start button, and then select Run.
2. Type cdplayer.

Using an Audio Mixer

When using an audio mixer with Avid Xpress DV, you should use shielded audio cables to connect the mixer to your computer. If you don’t use shielded audio cables, excessive noise might occur in the audio output during audio scrubbing.
Audio Tool Input Slider

The Input slider in the Audio tool does not have a scale on it. The unity gain point is correct only for an analog line, not for a CD-ROM, microphone, or the IEEE 1394 standard FireWire. The slider cannot be used to completely silence audio; the hardware does not have enough range to do this. Therefore, the lowest value on the slider is not equal to minus infinity.

Avid DV Codec

Avid Xpress DV Release 3.0 uses the new Avid DV codec as the default. For the best image quality, you should use the Avid DV codec whenever possible. The Avid DV codec requires a license key (dongle).

Recommended Workflow for Exporting Media to a Non-Avid System

To export media to a non-Avid system:

1. Choose Export from the File menu.
   The Export As dialog box appears.
2. Click the Options button.
   The Export Settings dialog box appears.
3. Choose QuickTime Movie from the Export As menu.
4. Deselect the Use Avid DV codec option.
   The Apple® QuickTime® DV codec will be used automatically once the Avid DV codec is deselected.
Third-Party Software

With Avid Xpress DV Release 3.0, Avid has included third-party software to enhance your videos. To run these applications, follow the instructions on the CD-ROM provided to install the software. On some of the third-party CD-ROMs, online documentation might be provided.

For questions or technical support regarding the various third-party software applications, contact the appropriate vendor.

Uninstalling Previously Loaded Third-Party Applications

Before reinstalling any third-party application, you need to manually uninstall first.

1. Click the Start button, point to Settings, and then select Control Panel.
2. Double-click Add/Remove Programs.
   The Add/Remove Programs dialog box appears.
3. Locate the application you want to uninstall, and click Change/Remove.
4. Follow the instructions.

Avid AVI Codec Uninstall

If you have the Avid AVI Codec previously installed on your system (from an earlier release of Avid Xpress DV), you need to manually uninstall this before installing the Avid Xpress DV application and the new Avid AVI Codec.
Preparing Your System for DVD Creation

The following section describes steps to take when creating a DVD.

Project Sample Rate and a DVD

Before you choose Create DVD from the File menu, set the project sample rate to 48 kHz.

- If you use the DVR-S201 DVD-R Drive, use the 3.95 GB Media.
- If you use the DVR-103 DVD-R Drive, use the 4.7 GB Media.

Create DVD Commands

The Create DVD Volume command on the Create DVD pop-up menu burns sequences directly to a DVD-R burner. The Write to DVD command saves the DVD Volume folder on a drive. DVD recordable media can be played back on most DVD set-top players. The DVD Volume folder can be played back on most DVD software players and can be used in DVD Authoring applications.

Create DVD Requires DirectX 8.1

If you are using the Create DVD command in the File menu to create DVDs, DirectX 8.1 is required. If you receive a message stating that you need to install DirectX 8.1, do the following:

1. Insert the Avid Xpress DV CD-ROM.
2. Click Browse CD.
3. Double-click the Goodies folder.
   This unzips all associated files.
5. Click the dxsetup.exe icon.
6. Follow the instructions.
7. After installing DirectX 8, reboot your system.
Recommended Workflow for Creating DVDs with Avid Xpress DV

Avid Xpress DV offers several options for creating your video sequence on a DVD. The following are recommended workflows for this process.

For more information on creating files for a DVD, see the Avid Xpress DV User's Guide.

One-Step DVD Creation Within Avid Xpress DV

This workflow is recommended when you have DVD writing hardware connected to your system and you want to write directly to the DVD. This workflow does not allow you to use a DVD authoring product such as Sonic Solutions™ DVDit!™. It is a fast technique for writing a video sequence to a DVD with no menus. The user plays the DVD by pressing “Play” on the DVD player.

To use this workflow:

1. Choose an export template in the Settings scroll list that contains MPEG-2 parameters.
2. Select a sequence in a bin.
3. Choose Create DVD from the File menu.
   The Create DVD dialog box appears.
4. Choose Create DVD Volume and Write to DVD from the Function menu.
5. Click the Browse button to choose a destination folder in which to store the generated files.
6. (Option) In the Export Settings dialog box, click Modify to make any changes to the MPEG-2 export template.
7. Click OK to start the export.
Workflow for Creating a DVD with an Authoring Tool

This workflow is recommended when you want to create a DVD with an interactive menu. It exports your sequence in a format that can be used by an authoring product such as Sonic Solutions DVDit! to add interactive menu capabilities.

To use this workflow:

1. Choose an export template in the Settings scroll list that contains MPEG-2 parameters.
2. Select the sequence in a bin.
3. Choose Create DVD from the File menu.
   The Create DVD dialog box appears.
4. Choose Export MPEG-2 and WAV files from the Function menu.
5. Click the Browse button to choose a destination folder in which to store the generated files.
6. (Option) In the Export Settings dialog box, click Modify to make any changes to the MPEG-2 export template.
7. Click OK to start the export.
8. Start DVDit! and open the exported MPEG-2 (.m2v) and Wave (.wav) files in the project.
9. Use DVDit! to burn to a DVD-R Drive.

cleaner EZ

Avid supports cleaner™ EZ to export to all popular Web formats. You can export to cleaner in one step by choosing Send to Media Cleaner from the File menu, which then exports a QuickTime reference movie and launches the cleaner application.

To use cleaner with your Avid Xpress DV system, install cleaner EZ from the CD-ROM provided by Avid.
The About box in the cleaner EZ 5.0.3 application states the version number incorrectly.

To run this application, register your copy of cleaner EZ to get your serial number.

To register your copy of cleaner EZ:
2. Choose your geographical area.
3. Under “former Media 100 products,” click “Register here for all versions of cleaner EZ.”
4. Fill in the registration form.

Avid Xpress DV supports cleaner 5.0.3 or later. If you have cleaner 5.0.3 or later installed on your system, you do not need to install cleaner EZ.

Pinnacle Commotion DV (PowerPack Users Only)

To register and obtain a serial number for your Commotion™ DV application, follow the instructions at the Pinnacle Systems Web site:

www.commotionpro.com

Scroll to the bottom of the page, and click the Avid logo.

MPEG-2 Files

You will be able to play an MPEG-2 file only with an MPEG Player. If you do not have an MPEG Player, you can go to www.ligos.com and click Store to download (for a fee) the LSX-MPEG Player 3.5.
Sonic Solutions

Included with the Avid Xpress DV system is a Sonic Solutions CD-ROM that includes DVDit! LE (DVDit! SE is included when you purchase the Avid Xpress DV PowerPack.) DVDit! is a DVD authoring tool. To use DVDit! with your Avid Xpress DV system, install the DVDit! application from the CD-ROM provided by Avid. To start this application, use the serial number supplied on the label attached to the CD-ROM sleeve.

Sonic Solutions offers other versions of DVDit!.

To upgrade DVDit! when the Goodies folder icon does not appear on your desktop:
1. Insert the Avid Xpress DV CD-ROM.
2. Click Browse CD.
3. Double-click the Goodies folder.
4. Double-click the DVDit! .html file.
5. Click the Web link.

This connects you to the Sonic Solutions Web site.

To view MPEG-2 files, Sonic Solutions also provides an MPEG decoder for playback. If you do not have a decoder installed already, you might want to install this. If your system has a DVD drive (external or internal), then a decoder is already installed.

RealPlayer

RealPlayer® is not supplied with Avid Xpress DV, but you can download this application for free from the RealNetworks Web site at www.real.com.
Web Software

The third-party application QuickTime has been installed automatically with Avid Xpress DV. Avid has qualified this QuickTime version installed on the Avid Xpress DV CD-ROM. Downloading newer versions of this application before it is supported by Avid might cause problems. Avid recommends not updating these applications until they are officially supported by Avid.

To access the most up-to-date information, check the Knowledge Center.

Suggestions for Optimum Performance

Windows is a multitasking operating system. However, background tasks can interrupt time-critical operations, such as recording, playing, or rendering. Make sure that background tasks are not running while you are working in the Avid Xpress DV system.

The following list contains suggestions for ensuring optimum performance when working with the Avid Xpress DV system:

- Do not leave a Windows Explorer window open. Windows Explorer will try to update file information.
- Do not leave other applications open. Some applications, such as Microsoft Office, run background processes.
- Do not leave an e-mail application open if it is set to do periodic checks for mail.
- Do not schedule automatic backups at times when your Avid Xpress DV system might be in use.
- Do not start any application that includes prescheduled or automatically scheduled activities, such as a calendar program.
- Do not keep antivirus software running in the background. Some antivirus software will try to scan media files while you are
recording. This might cause underruns or other application problems with Avid Xpress DV.

- Do not use large graphics as wallpaper.
- Do not allow the Find Fast background process (find.exe) to run. The process will try to update its cache of file and folder locations. Check your Startup folder and delete the file if it is there.
- Disable screen savers.
- Do not transfer network data during critical operations.
- Do not insert a CD-ROM in a CD-ROM drive during time-critical operations. Most CD-ROM drives and software perform an autoscan or autostart operation. The Avid Xpress DV system is shipped with autostart disabled.
- Disable AutoPlay
  To do this:
  Double-click the My Computer icon. From the Tools menu, choose Folder Options. In the Folder Options dialog box, click the File Types tab. In the Registered file types section, click AudioCD (this might be approximately half way down in the list). Click Advanced. In the Edit File Type dialog box, click Play, (if play is highlighted, it is enabled) and then click Set Default. Click OK, and then click Close. This will disable AutoPlay.
- If you have more than one drive, your media should go on another drive other than the one containing the operating system files.
- Always use small fonts to avoid missing characters in the application dialog boxes. To review font settings, right-click the desktop and choose Properties. Click the Settings tab in the Display Properties dialog box, and then click Advanced. Choose Small Fonts from the Font Size list.
- Deselect all Visual effects options in the Effects tab of the Display Properties dialog box.
- Disable the Microsoft Office Shortcut Bar. When this feature is enabled, the tops of the Avid Xpress DV windows get covered by the Microsoft Office Shortcut Bar.
Documentation for Release 3.0

The following documentation is included with this release:

- *Avid Xpress DV What's New for Release 3.0*: Describes all the new features for this release.
- Avid Xpress DV Help: Includes all procedures and new features for this release.
- Avid Xpress DV Tutorial CD-ROM: Includes the media and project folder you will need to go through the step-by-step tutorial included in the *Avid Xpress DV Getting Started Guide*.
- *Avid Xpress DV Online Publications CD-ROM*: Includes a .pdf of each Release 2.0 manual available with Avid Xpress DV. Also available on this CD-ROM is a complete glossary of Avid editing terms, and a quick and easy tour that describes the basics steps to edit video with Avid Xpress DV. The documentation on this CD-ROM has not been updated for this release.

Hardcopy Documentation

The hardcopy manual of the *Avid Xpress DV Effects Guide* is not included with Avid Xpress DV Release 3.0. You can view this manual and print it out from the *Avid Xpress DV Online Publications* CD-ROM. Additional hardcopy documentation can be ordered in the United States and Canada by contacting Avid Inside Sales at 800-949-AVID (2843). Outside North America, please contact your local Avid Reseller.
The following information has changed in the Avid Xpress DV documentation.

**Avid Xpress DV Getting Started Guide Change**

The following information has changed from the *Avid Xpress DV Getting Started Guide* Release 2.0. Pages 5-2 through 5-5 describe how to open the Avid Xpress DV tutorial project. This feature has changed dramatically with Release 3.0.

You no longer have to select or create a user. Follow the steps on page 5-2 and 5-3, but disregard page 5-4 or any steps to select a user.

On page 5-5, select Introducing Avid (NTSC) or Introducing Avid (PAL). If the project name does not appear, click the Browse button to locate where you stored the tutorial project.

**Avid Xpress DV Help**

The following information has changed in the Avid Xpress DV Help.

**Using Dual Monitors**

The Help system and the *Avid Xpress DV What’s New for Release 3.0* incorrectly states:

**To view dual monitors:**

- Click the left edge of the Composer monitor, and drag it to the left.
  
  The monitor splits into two. When you drag a sequence into the Timeline, it appears in the right monitor.

You can actually click either edge (left or right) of the Composer monitor, and drag it to reveal two monitors.
Track Selector Repositioning

The Help incorrectly states that you can “Ctrl+drag the Track Selector button to reposition tracks vertically in the Timeline.” This is not a feature with Avid Xpress DV.

Connecting to Both a Transcoder and the Remote Output on a Deck

The following information is not included in the Help. When simultaneously connecting your system to a transcoder and the remote output on a deck, make sure that both devices are configured.

Each device will need a separate channel. If two channel configurations do not appear by default in your Deck Configuration dialog box, do the following:

1. In the Deck Configuration dialog box, click Add Channel.
2. Choose FireWire as your Channel Type and OHCI as your Port.
3. Click Add Deck, and configure the transcoder as explained in the Help under “Configuring Decks.”
4. Click Add Channel again and choose Direct as your Channel Type and COM1 or COM3 as your Port.
5. Click Add Deck, and configure the deck to which your remote cable is connected as explained in the Help under “Configuring Decks.”

Avid Xpress DV User’s Guide Change

The following information was omitted from the Avid Xpress DV User’s Guide.

Chapter 10, “Managing Media Files,” should include the following information about Refreshing Media Databases.
Refreshing Media Databases

Refresh the media directories after you remove media from the media drives (for example, after you have physically moved drives). The Refresh Media Directories command reexamines all the media databases on the system. This command can take a long time to execute on systems that have large amounts of media online.

To refresh media databases:

- Choose Refresh Media Directories from the File menu.

Avid Xpress DV Effects Guide Change

The following information was incorrect in the Avid Xpress DV Effects Guide.

Non-Keyframeable Effects

The Avid Xpress DV Effects Guide incorrectly states that color effect parameters are keyframeable. Luma Adjust, Luma Range, Luma Clip, Chroma Adjust, Color Style, and Color Gain are not keyframeable effects.
Additional Notes on Operation

For specific issues with cameras, check the Knowledge Center.

Audio

- When using the Yamaha® SXG driver, you might experience audio hardware underruns when playing back audio.

  Workaround: Quit Avid Xpress DV and set the preferred playback device to Sound Max Digital Audio.
  1. Click the Start button, point to Settings, and then select Control Panel.
  2. Double-click Sounds and Multimedia.
     The Sounds and Multimedia Properties dialog box appears.
  3. Click the Audio tab.
  4. In the Sound Playback section, choose Sound Max Digital Audio from the Preferred device pop-up menu.
  5. Select “Use only preferred devices.”
  6. Click OK.

- When playing a calibration tone to both the camera and the consumer audio line (DV OHCI/1394) out, the frequency of the tone heard on the consumer line will change.

  Workaround: If calibrating the audio going to the DV OHCI/1394 line, listen to the output through the camera, rather than the consumer audio line out. Disable the output to the camera. Double-click the Video Display settings from the Project Settings window, and then click the Client monitor option to deselect it.
➤ You might experience excessive noise when connecting your computer headphone output to outboard audio equipment, such as a studio mixer or powered loudspeakers. This is due to the signal grounding arrangement in both the external audio hardware and in the computer, and is especially apparent on some laptop models.

**Workaround:** Use a ground-loop isolator, available at RadioShack (part # 270-054), between the computer headphone output and the outboard audio equipment.

### Digital Cut

➤ Most Sony brand DVCAM devices will break the solid timecode on the tape after the tape is used for Digital Cut.

**Workaround:** Add black to the beginning and end of the sequence before recapturing.

➤ When using the Sony DAC-2 (NTSC) transcoder for a digital cut, the chroma does not lock.

➤ When working in PAL, the Laird FFP transcoder outputs very poor quality analog video.

➤ Duplicate frames might appear during a digital cut. When performing a digital cut on certain non-Sony cameras, you might experience double frames of audio and video. This is caused by the deck not handling asynchronous and isochronous commands over the 1394 FireWire at the same time.

**Workaround:** In the Deck Preferences Settings dialog box, deselect “Poll deck during digital cut.” However, with this disabled, the timecode display and the Play button in the deck control portion of the Digital Cut tool will not update while performing the digital cut.
➤ You cannot perform an audio only digital cut longer than 10 minutes.

Workaround: Include video in the digital cut.

➤ Inaccurate timecode occurs when using mixed frame rates (non-drop-frame and drop-frame) and DVCAM recording format.

Effects

➤ With real-time effect enabled, parking on some AVX plug-in effect causes the effect to display incorrectly.

Workaround: Render the effect or disable real-time effects.

➤ If you change the name of a motion effect clip, export it, and then import it into another system, the clip will retain its original name. It does not retain the changed file name after import.

Export

➤ An OMFI export will fail with a sequence that has an image effect clip at the start of the sequence. This is due to the 2-GB limit.

➤ If you don’t have cleaner EZ installed on your system, and you attempt to export to cleaner EZ, an access violation error occurs.

➤ Cleaner EZ does not support 16:9 file format. You can’t export a 16:9 file format to Media Cleaner EZ.
When you export a QuickTime DV stream file at 32 kHz, make sure you select “Audio format locked” in the QuickTime Codec Options dialog box. If you don’t, you will have audio dropouts when you play the file in the QuickTime Player.

Import

While logged in as a Power User, limitations occur when you import from a CD with multiple SCSI or IDE CD/DVD drives connected. Power Users will be limited to the drive with the highest bus ID for CD import. Avid Xpress DV will not prevent you from selecting a track from a CD (with a lower bus ID drive), but when you try to import the track, a dialog box appears informing you which drive to use. Power Users can not import audio from a CD with Firewire CD/DVD drives.

Importing a QDesign Music 2 file, formatted as a QuickTime® movie, plays back with stuttering audio at the end of the sequence.

White frames display when batch importing an offline sequence that contains a consolidated QuickTime movie.

Hardware

The SIIG Cardbus Dual 1394 and the Sony AJ-D250E deck is not compatible with PAL 4:1:1. This is because the SIIG card and the deck run in different power modes.

Workaround: Use an ADS 1394 Adapter, or install a 1394 hub between the SIIG OHCI board and your AJ-D250E deck.
Media Files

➤ If the Media tool opens with a drive selected, it isn’t selected properly; you need to select the drive again.

➤ Media files deleted from the OMFI MediaFiles folder (located outside the application) do not display as “Media Offline” properly.

Workaround: Delete the media databases and rebuild them for the offline functionality to work properly:

1. Quit the Avid Xpress DV application.
2. Locate the OMFI MediaFiles folder.
3. Delete the .pmr and .mbd files.
4. Start the Avid Xpress DV application.

The media database rebuilds when you start the application.

Playback

➤ You can’t use the L key for variable speed play (3x or 4x) when the Record tool is open.

➤ The Dell® 330 system with an NVIDIA® display card installed plays back a flash of distorted video periodically.

➤ Video stutter occurs on a Dell 330 system when playing back at a high speed through the camera.
Recording

➤ **Driver errors might occur when switching between transmitting to and capturing from the DV device.** This problem seems to occur more frequently with certain DV devices. This problem occurs because the OHCI driver can intermittently get into a bad mode when the input and output mode of the driver changes. When you have a device connected to your system and the video display settings are set to “send data to the DV device”, and you have real-time effects disabled, before switching between transmit and capture, first close the Record Tool window. This will enable the driver to easily switch between transmit and capture modes. When the driver gets into this bad state, several things can indicate this:

- The timecode window in the Record tool continually displays “waiting” and the device no longer accepts device control commands.
- Playback in the Composer monitor plays for a few seconds, then hangs, and will typically respond with an ADM overrun error. Playback from the Composer monitor will do this consistently.

The Record tool continually responds with “no input signal present” when in fact, a DV device is connected to the system.

**Workaround:** Cycle the power on your DV device. If the error persists after cycling the power on the DV device, reboot your system to force the TI driver to restart.

➤ **Recording across timecode breaks sometimes fails when using a transcoder.**

➤ **Video and audio might stutter during pass through recording.**

➤ **Autosync with Source timecode does not work properly when recording through a transcoder.** The audio and video are out of sync.
If you autosync two clips by IN point (one video clip and one audio clip), but no IN point has been set, the video and audio sync will be off by one frame.

**Workaround:** Go to the head of the clip and set an IN point.

Line levels record very loud when the default of +20 dB Gain is used.

**Workaround:** Select the +20 dB Gain check box in the Audio tool, above the Input slider.

**Third-Party Applications**

Importing a QDesign Music 2 file, formatted as a QuickTime movie, plays back with stuttering audio at the end of the sequence.

Exporting to a QuickTime 5.0 file with the pan set to the extreme left or right splits over both channels. This is apparent only on a Dell® Precision Workstation 330.

**Workaround:** Disable the Stereo Wide feature.

**To disable the Stereo Wide feature:**

1. Click the Desktop.
2. Double-click the Speaker icon located in the bottom right corner of the Desktop.
   
   The Play Control Panel dialog box appears.
3. Click Options, and then choose Properties from the menu.
4. Make sure the Playback option is selected.
5. Click the Stereo Wide option to select it.
6. Click OK.
7. Close the Play Control Panel dialog box.
Running more than one application at a time causes errors. Most video applications create a DirectDraw overlay surface, which writes video. DirectDraw allows only a single overlay surface to exist at one time. A video application would have to stop running before a second video applications starts.

**Workaround:** When running both Avid Xpress DV and QuickTime 5.0 at the same time, play the video all the way through to the end in QuickTime. This allows the appropriate resources to release from QuickTime in order to run Avid Xpress DV.

Using the headphone output on the Sony VAIO inverts the polarity.

If a JVC® device is not running when you arm a track (video or audio) in the Record tool, the JVC device cannot send data to the 1394 FireWire. When you play from the deck controls in the Record tool, the JVC device plays and displays video on the JVC device; however, you do not see or hear anything on the desktop. If you click Record in the Record tool, you see an error message that there is no signal data.

**Workaround:** Turn on the JVC device before arming any tracks in the Record tool.

cleaner EZ installs a DV codec that causes a QuickTime export to fail when using the AppleDV compressor.

The Send to Media Cleaner option is not available when cleaner EZ is installed on a secondary partition.

**Workaround:** Install cleaner EZ on your C: drive.

A RealMedia™ file having two periods in a row in the file name causes RealPlayer 7 to crash when you play a file exported from Avid Xpress DV.
Timeline

➤ The audio meters in the Timeline do not update when a DV device is connected to the Avid Xpress DV system.

Workaround: Use the audio meters in the Audio Tool.